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DiscDBxx is a combination of a database program for keeping a list of
compact music discs and to use a CD-Rom drive to assist in creating
the database. The program will also just play CD music discs, if the
neccessary hardware/software exists.
  
DISCDB16.EXE will function in Windows 3.1(tm), Win95(tm) or the
Windows NT(tm) operating system. The PMC logo will show a 16.

DISCDB32.EXE will only function under the Win95(tm) or Windows NT(tm)
32 bit operating system. The PMC logo will show a 32.

The software assumes that the Window's(tm) sound driver is loaded and
that your CD player(s) already reads CD-Rom files/plays games etc. If
you require more information on the sound driver or your CD-Rom, please
consult the manuals provided for the operating system, the sound card,
and the CD-Rom device manufacturer.
  
A good set of headphones or your sound card connected to a nice sound
system also helps, if you want to enjoy the full reasoning and benefits
of this custom developed software program.

Although the software is designed to be intuitive, this manual covers
the specific details on the use/creation of a music disc database and
the operation of a CD-Rom drive to play music discs. The software also
includes a Windows(tm) help file, that can be accessed from the program
main menu, under the heading of Help.
  



INSTALLATION....

Installation of the software is achieved by using the provided SETUP
program. This process only takes a few minutes and when completed, all
that needs to be done is to click with your mouse on the Disc Player
DB icon, in the Disc Player DB folder.

Using old style Windows(tm)....

To Install the program, insert the floppy disk into drive A: and then
in the Window's Program Manager, select FILE, and then select RUN. At
the RUN dialog, type in A:\SETUP and press the enter key.

Using Win95(tm)....
Invoke the Control Panel. Click on Add/Remove programs. At the dialog
click on `INSTALL'. The Setup Wizard will find Setup.exe and then
follow the prompts to complete the installation.

For users of the new Windows(tm) interface, the original install will
have the new folder on the desktop. For next use of the software, the
requirement is clicking of the START button, move the mouse pointer on
PROGRAMS, then move the mouse pointer on to PMC's Disc Player, which
will then generate the folder listing.

Whenever the software is started, it will automaticly create a new
disc player database, or open the last disc database that was in use.

The software requires an INI file. This is included with the SETUP
installation. The Disc Player DB will also create a new INI file, if
an original file can not be found in the Windows(tm)operating system
directory. This new INI file will appear after the software is ended
or shut down.

Please see the details under the heading of INI File for more details
on what should be changed to customize the Disc Player database for
your specific word processor and your computer system sound card.
  



MAIN -> SUB MENU COMMANDS:

File -> Create
       Create a new Disc Player database file or open an existing file.
    -> Open
       Open an existing Disc Player database file.
    -> Print -> Current
                Print the current viewed record to a file.
             -> Number
                Print records from number to number, to a file.
             -> All
                Print all the records to a file
      Any print command will then load a word processor for printing.
      The default word processor is Windows(tm) Notepad. See the Ini
      file settings to change this to your own choice/word processor.

    -> Delete Print File
       Delete any previously made Print file, if it exists.
    -> DiscDB
       PMC Systems Software Copyright Notice
    -> Exit
       Terminate the program.



Edit -> New
       Create a new compact disc database record to fill/edit.
    -> Modify
       Edit or modify an existing CD database record.
    -> Cancel
       Stop or cancel a new or existing edit of a database record.
    -> Save
       Save to disk the new or modified edit of a database record.
    -> Restore
       Using the backup file, restore or replace a database record.
    -> Delete
       Erase or delete the current viewed database record.
    -> Copy To Clipboard
       Copy the current viewed record to the Windows(tm) clipboard.
       This data block can then be pasted into another program file.
          
View -> First
       Move the CD database pointer to the first record and view.
    -> Previous
       Move the CD database pointer to the previous record and view.
    -> Next
       Move the CD database pointer to the next record and view.
    -> Last
       Move the CD database pointer to the last record and view.



Locate -> First
         Bring up the dialog to begin a search process.
      -> Next
         Continue the search after a search value has been found.
      -> Previous
         Go back to a previous search value that had been found.

Font -> Sans Serif   -> Small
                       Use a small Sans Serif font.
                    -> Large
                       Use a large Sans Serif font.

    -> Arial        -> Small
                       Use a small Arial font.
                    -> Large
                       Use a large Arial font.

    -> Courier New  -> Small
                       Use a small Courier New font.
                    -> Large
                       Use a large Courier New font.

    -> System
       Use whatever font is the system default.



Options -> Select Play
          Enter specific CD track numbers to play. Use only existing
          track numbers. See more detail under `Hints and Tips'.
       -> Shuffle Play
          Turn on/off random playing of CD tracks. A random track can
          be skipped by using the track up button or menu command.
             
       -> Continuous Play
          Turn on/off CD track play as continuous. Turn this on for
          concept albums, or to enhance the single track play. This
          choice will be turned off if Shuffle play is selected.
             
       -> Music Timer
          Turn on/off the timer Play/Run windows that view CD timing.
          This feature is not necessary for listening enjoyment. The
          Play window will show track elapsed time, while the Run
          window shows total CD elapsed time relative to the track
          elapsed time, plus 2 seconds.
             
       -> Format Edit
          Turn on/off the feature to format the entry text. This will
          force the first letter of each word to upper case and the
          remaining letters of a word to lower case. Use a space to
          force a character to upper case if needed.
          When turned off(no check mark), then data is formatted and
          saved to exactly what is typed in the data fields.
       -> Audio Mixer
          Call or execute the mixer program for your sound card. This
          option is set in the INI file. See INI file for more detail.
       -> Window Full
          Set the program window to either Full or Small.      
       -> Always On Top
          Turn off/on function to keep the program window on top. 
      -> Tool Tips
          Turn tooltips off/on. Only available in the 32 bit version.



Player -> Stop
         Stop playing the compact disc.
      -> Eject
         Eject or open the CD player door if applicable.
      -> Play
         Begin Play or restart play of a compact disc.
      -> Pause
         Hold or pause play of a compact disc.
      -> Skip Forward
         Move the play approximately 10 seconds forward into the track.
      -> Skip Back
         Move the play approximately 10 seconds back in the track.
      -> Track Up
         Cancel current track and play the next.
      -> Track Down
         Cancel the current track and play the previous track.
      -> Set Player #
         Select the CD drive to use for playing compact music discs.

Help -> Glossary
       Alphabetical listing of program information and use.
    -> Contents
       Base topic menu for program main menu commands.
    -> Close Help File
       Close or cancel the use of the program help file.



DATA ENTRY....

The database is normally in read only mode.

Select Edit from the main menu and then select New for a new record.
The track times are filled in for you when the CD is read for a new
database entry. The player is activated with the new CD playing. It can 
be turned off, or you can listen while entering the disc information.
To Edit a record, select the record, then click on EDIT, and then click 
on MODIFY. Answer Yes to change the record. Insert the new compact disc.
Select Play.  The procedure is then the same as adding a new record.The 
deleted record, then becomes as a new record.

The Product# field is for the bar code number. The Catalog: can be used
for your own choice or for the CD number, which usually duplicates the
bar code number. The remaining data fields are self explaining.
  
The Product# and Catalog fields allow a maximum character length of 14.
Remaining entry fields allow for a length of 64 characters.

The program automaticly creates a backup file of all records as they
are added to the database. This file is kept in the current directory.
  
Database records can be deleted, but they are never removed from the
file itself. The backup file keeps a complete copy of an original
record, even if the original is deleted. In the case of accidental
delete, the Restore command can be used to read the backup file and
then overwrite the record showing as deleted.

Please note however, if a record is modified, the modified copy is
saved to the backup file, and the backup can `not' then be used to
reverse the new modifications.



THE INI FILE...

The program INI file is located in the base Windows(tm) sub directory.

When you edit this file, it should be done with the Window(tm) Notepad
or any text editor that will save the file as plain ASCII text. If the
file is not saved properly, then it will be corrupted and will not
function as necessary.

Editing of the file is required for your placing the name of the sound
card mixer, that is provided by the manufacturer. This will then give
you the use of calling the mixer program from within Disc Player DB.
The mixer program name varies to the brand of your sound card.

Another item that can be changed is the use of a word processor to
print any of the database records. Disc Player DB doesn't use a print
feature and relies completely on your word processor. The default is
the Windows(tm) Notepad, thus NotePad=Notepad, but could be set to
NotePad=Write, to use the Windows(tm) Write word processor.
  
All the other settings are created or modified from the program itself
or from the menu selections.

It is best if you leave the settings for the file information to be
used and changed by the Disc Player program. This data is changed and
saved whenever a new database file is created or opened.

If the INI file becomes corrupted for any reason, delete the old, and
then start up Disc Player. Use any favourite menu settings, such a
shuffle play and format edit text, and then exit the program. This will
create a new ini file. You can then edit the new ini file for the naming
of your word processor and system sound card.

The next page contains the default values for an ini file, when the
software is installed on hard disk drive C:



[Program]
ProgramPath=C:\DISCDB16\DISCDB16.EXE
HelpFilePath=C:\DISCDB16\DISCDB16.HLP
[WindowsWordPro]
NotePad=NotePad.Exe     ; change this to your word processor name
[AudioMixer]
MixerName=MIXER.EXE     ; change this to your sound card mixer name
[Data]
DataDrive=C:
DataPath=\DISCDB16\
DataName=DISCDB16
DataExtention=.DAT
[Backup]
BackupDrive=C:
BackupPath=\DISCDB16\
BackupName=DISCDB16
BackupExtention=.BAK
[Error]
ErrorDrive=C:
ErrorPath=\DISCDB16\
ErrorName=DISCDB16
ErrorExtention=.ERR
[Print]
PrintDrive=C:
PrintPath=\DISCDB16\
PrintName=DISCDB16
PrintExtention=.PRT
PrintZeroTime=1
[DiscPlay]
ContinuousPlay=1
DiscTimer=0
ShufflePlay=0
PlayerDrive=0
[Font]
FontSize=2
FormatEditText=1
[Network]
UseNetwork=0   ; change this to a 1 for network use



HINTS & TIPS....
  
Single track play can be done by selecting a numbered button for the
track. Non disc tracks can be selected but not played. If Continuous
Play is turned on, then play will continue to the next tracks, after
the single play, otherwise the player is shut off, after the selected
track is finished playing.

Shuffle play is a total random process. It is uneffected by single
track play, meaning, shuffle play can be turned on, and single track
play can still be used. Shuffle play tracks can be skipped or scaled
up by selecting track up.

Continuous Play or Shuffle Play can be turned on, but not both at
the same time, however both, can be turned off.
  
The Select Play, is not effected by either Continuous Play or Shuffle
Play being turned on. Select Play will only play tracks that exist
and these can be scaled by using track up or track down. A track #
that doesn't exist will cause Select play to stop all play.
  
The Pause button will pause play, which can be restarted by pressing
the Play button, or pressing the Pause button again. Pressing Play
after a track is playing, will restart the current track.
  
The program also contains a command line feature. It will respond to
two commands, of either `shuffle' or `play'. The play command can be
extended to include specific track numbers, such as play 2 4 6 8, to
play only those tracks.

When a command line is used, the program loads, shows itself, checks
for a compact disc, begins playing in the style requested, and then
the program window is minimized.

If the program doesn't find a compact disc, it remains to being full
window and then waits for your input.



The main database file has a .DAT extention. The backup file has the
.BAK extention, while .ERR is used as an error file and .PRT is used
for the print file extention.

A dialog box is given with the error message, should an error occur.

This software allows shared or network file access. However, each INI
file is for a specific machine. This means that the software and its'
database can be on another machine, but the INI file will only work
with the machine that is using the program. This is done for several
reasons, one of which, is to always know which sound card mixer to
use on the current machine. Use a value of 1 for UseNetwork if this
software will be used in a net environment.
  
Although the program automaticly makes a backup file with the .BAK
extention, it is suggested that a backup is kept either on a floppy
disk or in another drive location, as part of your regular system
backup procedures. Copy over either file, if corruption occurs in
either file. As example, copy the .BAK to .DAT if necessary.

There are many different CD-Rom players. Some of the older models didn't
track very well, and can cause audio discs to skip/jump if there is any
trace of dirt or a surface scratch on the platter itself. Follow the
instructions to keep the disc clean, and the optic reader clean. High
volume with external speakers, pumping solid bass will also cause tracks
to skip.
  
If you experience a reverb echo effect when pausing or stopping play,
restart the play and stop it again. This can occur if the process is
interrupted by another running program under multitasking. The effect
is rare, should not cause any damage, but is an ear bang.

If audio playback continues to skip or lock in a track, stop the play,
remove the disc, and clean the disc surface. Finger acid, potato chip
grease and other materials effect the optic reader ability.

It is hoped that this software will continue to assist you in enjoying
your compact disc music collection.



***********************************************************************
                       Registration  Agreement
***********************************************************************

Between:   PMC Systems Software,  And the purchaser

Name _________________________     LAN Name/Version __________________

Address _______________________    Computer/Server ___________________

City  _______________    State/Province __________________

Country _______________    Postal Code ____________

Voice Phone # (___)___-____     Fax/Data Phone # (___)___-____

Windows(tm) version ____________________   Date __/__/__

Please include the fee of $20.00 in a cheque or money order. Add ten 
dollars to receive an enhanced version for Win95(tm) or Windows NT(tm).
The registered versions are DBF file format compatible. A conversion 
progam is supplied to convert data from the generic file format. The
DBF file format, as example, is used with FoxPro(tm), Clipper(tm) and 
Paradox(tm). Call or write, for more details on registration.
Send any written inquiry and registrations to:
                        PMC Systems Software
                         134-17th Ave. N.E.
                          Calgary, Alberta,
                           Canada, T2E-1L6
Any verbal inquiry can be made to the voice line at (403)230-2700
or send internet email to: pmcsys@agt.net
Internet home page: http://www.agt.net/public/pmcsys/pmcsys.htm



***********************************************************************
*                           THE LAST WORD                             *
***********************************************************************

DiscDB16 software was developed for the 16 bit Microsoft Windows 3.1(tm)
Operating System. Another version, DiscDB32 is for the 32 bit Microsoft
Win95(tm) / Windows NT(tm) Operating System(s). Microsoft Visual C (tm)
was the development product of choice under either of the mentioned
operating systems.

Please read the licence agreement for your purchase and mail in the
software registration.

Any references to Microsoft(tm), Visual C(tm), Windows(tm), Win95(tm)
Windows NT(tm) and any other trademarks are stated strictly for their
notification value of trademark, and should not be considered, implied,
or related to, PMC Systems Software.

Thank you for your support on this user friendly software product.

  Patrick M. Cohan,
  
  PMC Systems Software
  134-17th Ave. N.E.
  Calgary, Alberta,
  Canada, T2E-1L6
  September 25th, 1995



***********************************************************************
*                      PMC Systems Software Licence                   *
*                                                                     *
*                Copyright 1984-95 (c) - All Rights Reserved          *
***********************************************************************

PMC Systems Software hereby grants to the holder, the right of use to
this developed software with the commercial purchase of the same.
This is a copyrighted work. The holder of this software can not and
may not transfer any rights to any other user. The holder also can not
sell any rights to the software, nor can the software itself be sold,
without the expressed permission of the product developer.
The original purchaser is allowed to sell the original disk(s) and the
manual, and after the sale of the same can not retain or sell again
any rights to the software product.
Only the final purchaser has any rights to the software. These rights
are for any product updates or warranty.
PMC Systems Software hereby disclaims any warranties relating to this
software, whether expressed or implied, including without limitation
any such implied warranties of merchantability or a fitness for a
particular purpose. Warranty is covered on the provided disk media.

PMC Systems Software will not be liable for any special, incidental,
consequential, indirect or similar damages due to loss of data or any
other reason.

In no event shall PMC Systems Software liability for any damages ever
exceed the price paid for the license to use the software, regardless
of the form of the claim.

PMC Systems Software will assist registered users as it is necessary.
Because software can be modified after leaving the product development,
the person(s) using this developed software assumes any and all risks
to the quality and stated performance. If there is any question on the
quality, contact the author.

This developed software is subject to any and all government copyright
and protection that exists in any and all countries that recognize it
as such. Violators of this copyright will be prosecuted.


